3

Editing Audio

IN THIS CHAPTER:

6 Use LP and Tape Assistant to Edit Newly Captured Audio
7 Convert Audio File Formats
8 Add Tags to Audio Tracks
9 Add Tracks to Sound Editor
10 Split, Crop, and Join Tracks
11 Fade Volume of an Audio Track
12 Set the Right and Left Audio Track
13 Clean, Enhance, and Equalize an Audio Track
14 Add Effects to an Audio Track
15 Mix Multiple Audio Tracks
16 Export Audio
Besides being able to capture audio, Roxio Easy Media Creator 8 provides powerful audio-editing capabilities and several interfaces in which to edit audio. **LP and Tape Assistant** and **Quick Sound Editor** are abbreviated versions of **Sound Editor**, Easy Media Creator's full-fledged audio-editing application.

**LP and Tape Assistant** is a capture, edit, and export wizard that allows you to quickly process the audio you want to capture. The wizard gives you the option to export your audio to **Sound Editor** if you need more editing capabilities.

**Quick Sound Editor** can be launched from most of the audio project interfaces within Easy Media Creator. It has the fewest audio-editing capabilities, but is good for a quick clean up. Although it is not addressed individually within this chapter, all of its capabilities are found within **Sound Editor**.

**Use LP and Tape Assistant to Edit Newly Captured Audio**

**BEFORE YOU BEGIN**

Chapter 1, “Start Here” (Review information about audio file types)

Capture Audio Using LP and Tape Assistant

**SEE ALSO**

Add Tracks to Sound Editor
Split, Crop, and Join Tracks
Fade Volume of an Audio Track
Set the Right and Left Audio Track
Clean, Enhance, and Equalize an Audio Track
Add Effects to an Audio Track
Mix Multiple Audio Tracks
Export Audio

**LP and Tape Assistant** is a complete capture, edit, and exporting wizard. It’s useful if you would like to immediately edit the audio you have captured and then export it to whatever application or format you choose. If you are not familiar with the steps to capture audio in the assistant, refer to **Capture Audio Using LP and Tape Assistant**.

**LP and Tape Assistant** is a simplified version of **Sound Editor**, a full-fledged audio-editing application. Most of the tasks in this chapter focus on editing your audio within **Sound Editor**. If you would like to use the advanced editing power of **Sound Editor**, you can either launch **Sound Editor** instead of **LP and Tape Assistant** or you can export your captured audio to **Sound Editor** in the last step of **LP and Tape Assistant**.
Use LP and Tape Assistant to Edit Newly Captured Audio

1. **Capture Audio Using LP and Tape Assistant**

2. **Adjust the Track Separators**

3. **Edit a Track Using the Taskbar**

4. **Click Tags to Add Audio Tags for All Tracks**

5. **Clean Your Audio Tracks**

6. **Enhance Your Audio Tracks**

7. **Set Equalizer**

8. **Fade Your Tracks In and Out**

9. **Click Next**

---

*Use LP and Tape Assistant to Edit Newly Captured Audio*
1 Capture Audio Using LP and Tape Assistant
In the Roxio Creator Suite 8 Home page, launch LP and Tape Assistant from the project pane under the Audio heading by selecting Convert LPs/Tapes. Follow the steps to capture your audio and click Next. If you are unfamiliar with this process, refer to Capture Audio Using LP and Tape Assistant.

2 Adjust the Track Separators
Here’s your chance to really play with the tracks you’ve imported. Above your tracks is a header that labels each track you’ve recorded; in this case, 1 Recorded Audio, 2 Recorded Audio, and so forth. A line separates each track you’ve recorded. By holding your left mouse button and dragging those lines around, you can change the definition of the track boundaries. You can merge two or more tracks (or parts of tracks) or create a new clip entirely.

You can select any one of these tracks by highlighting the header. Or, by clicking anywhere inside the tracks, you can create a new selection line. You can leave it as a line in order to create a separator, or you can drag it to your preferred end point to highlight a larger selection. At any time you can preview your recorded audio by clicking the Play button at the bottom left of the screen to make sure you’ve selected the portion of the audio clip you want.

You can create a marker by right-clicking inside the track and choosing Add/Remove Marker from the context menu that appears. You can also do this by holding down the Control key and then clicking inside the audio. You create a new separator while leaving a marker in the place of your last separator. The marker appears as a little blue tab inside the dark upper border of the track view.

3 Edit a Track Using the Taskbar
You can edit a selected portion of the track by using the buttons on the top left of the LP and Tape Assistant window (called the taskbar). Listed in order, these buttons are

- **Undo**—Undo the last change you’ve made to the tracks
- **Redo**—Redo the last undone change
- **Rename**—Allows you to rename the selected track
- **Delete**—Allows you to delete a selected portion of the track
Use LP and Tape Assistant to Edit Newly Captured Audio

- **Add Track Separator**—Allows you to divide or crop tracks by adding a track separator
- **Delete Track Separator**—Allows you to combine tracks by deleting their separators

**KEY TERM**

*Taskbar*—A group of icons that usually appears at the top of any application you are using, although it is also very common to see them down one side. These icons make it convenient to complete tasks just by pointing and clicking. A taskbar is sometimes called a toolbar or toolbox.

**TIPS**

Right-clicking inside of the track gives you several options for more precisely selecting or moving around inside the tracks. You can also insert a silence of the duration of your choice by choosing the appropriate option from the context menu that appears.

Any time you have a portion of an audio clip selected, you can zoom to that selection by using the zoom tools in the upper right of your view or by right-clicking on the selection and choosing **Zoom to Selection**. When you are done editing your particular selection, you can zoom back to your full view by right-clicking and choosing **Zoom out Full**.

4 **Click Tags to Add Audio Tags for All Tracks**

After you have made your changes, click on the **Tags** button to add audio tags to your tracks. You can select any or all of your tracks and change their name, artist, album, genre, track number, and year. You can also assign track art. The **MusicID** button allows you to search the online database for your track information. This works if your tracks have been recorded in their entirety and you haven't made any major changes to them.

5 **Clean Your Audio Tracks**

When you have named your tracks, select the portion of the audio clip that you want to clean and click the **Clean** button on the **Clip Editor** toolbar. In the **Clean** dialog that opens, you can declick, decrack, denoise, or add noise manually by selecting **Custom** (the default) at the bottom right of the pane and adjusting the sliders for each function until the cleaning effect is properly applied. You can also have the effect applied via **LP and Tape Assistant** presets by choosing a low, medium, or high setting from the bottom-right drop-down menu. Play the track that you are cleaning to hear the effect as you adjust it.
CHAPTER 3: Editing Audio

Because the cleaning effects are layered on top of each other as you apply them, you should add the effects one at a time, adjusting each as necessary.

6 Enhance Your Audio Tracks
After you have cleaned your audio, you can enhance it by selecting the Enhance button. You can choose to enhance the Bass, or make your audio brighter by enhancing the Excite. There are no presets for either enhance function, so you’ll need to adjust the effects manually with the slider provided.

7 Set Equalizer
When you are satisfied with the enhancement settings of your audio, click the Equalizer button to use Easy Media Creator’s 10-band equalizer to change the levels of your audio track. You can use the presets or customize your settings by adjusting the levels manually. Customizing your settings is mostly a trial-and-error process, so change one setting at a time and preview your track to monitor the differences. There is a left and right channel indicator for each band. You can adjust each channel separately by deselecting the Link Channels option.

8 Fade Your Tracks In and Out
After you have set the equalizer, you have the option to fade your tracks. Selecting the Fade each track in & out option fades the beginning and ending of each track within the editor for the specified amount of time. Use the + and – buttons to increase and decrease the duration of the fade, or type your preferred time in the box provided.

9 Click Next
After you have completed your edits, click Next. This takes you to the final step within LP and Tape Assistant, where you have the option to burn your audio to CD or export it to a file on your hard disk. You are also given the option to continue editing your audio using the more advanced Sound Editor or to export the track to Music Disc Creator so it can be added to a project. For more information on exporting your audio, see Export Audio.

TIP
You can preview your audio by using the play buttons on the bottom left of LP and Tape Assistant. Use the slider to choose where you would like to begin the playback, and use the volume indicator to mute (by clicking on the speaker icon) or change your volume.
NOTE
As you add effects to your audio, you will notice Bypass and Difference check boxes in the effect adjustment windows. As you preview your audio, you can select Bypass to listen to your audio without the effect, or Difference to hear the difference the effect is having on the audio without the rest of the audio. Note that only the Clean dialog includes both a Bypass and a Difference check box. You can achieve the same effect as clicking Difference by simply deselecting Bypass when working in the other effects windows.

Convert Audio File Formats

BEFORE YOU BEGIN
Chapter 1, “Start Here” (Review information about audio file types.)

SEE ALSO
1. Capture Music Tracks from a CD
2. Extract Audio Tracks from a DVD
3. Add Tags to Audio Tracks

So you have folders full of imported music of every file type, and you want to convert some of those files to another format. For instance, if you want to edit a file, using the WAV format is by far the best option, but keeping all your files in this format is unrealistic due to their size (about 10MB per minute of audio). A number of compressed audio formats can help you store your music more efficiently, and Easy Media Creator supports several of them.

There are plenty of opportunities within Easy Media Creator to convert your files from one type to another. When you are importing them, you can choose your capture settings. If you load your Audio CD project with MP3s, Easy Media Creator automatically converts them to WAV files so you can listen to your disc on a conventional CD player. But if your goal is simply to change one file format to another, the following steps help you do so easily.

KEY TERM
Convert—To change a file from one format to another.

1. Select Audio in the Project Pane
   Select the Audio button in the project pane to open the Audio menu.

2. Select Advanced Projects
   Selecting the Advanced Projects option displays the Music Disc Creator project wizard. You use this wizard to determine what audio tracks you would like to convert, from what source, and where you will save them.
CHAPTER 3: Editing Audio

1. Select Audio in the Project Pane

2. Select Advanced Projects

3. Select Add Audio Tracks Or...

4. ...Select Import from CD/DVD

5. Browse to Find Audio Files

6. Select Tracks to Be Converted

7. Add Tracks to Music Disc Creator

8. Select Tracks Inside Music Disc Creator

9. Right-click on Selected Tracks and Choose Export

10. Set Output Settings

11. Choose Destination

12. Click Export

7. Convert Audio File Formats
3 Select Add Audio Tracks Or…
After you have launched Music Disc Creator, select the Add Audio Tracks option to open the Media Selector window. This enables you to browse for audio files already saved on your computer (or network drives).

4 Select Import from CD/DVD
After you have launched Music Disc Creator, select the Import from CD/DVD option to open Media Manager. This allows you to import tracks from an audio CD or to take the audio from a DVD track. This is an alternative method of extracting audio from a DVD. The other method is described in Extract Audio Tracks from a DVD.

5 Browse to Find Audio Files
After you have opened Media Manager, you need to browse through your drives and files to find the audio you would like to import. If you are searching for a file, it can be found on your hard disks. If you are importing from a CD or DVD, you need to select your CD/DVD drive.

6 Select Tracks to Be Converted
After you have browsed to the location of the tracks that you would like to edit, you can select one or more tracks to be imported into Music Disc Creator. Preview your tracks using the playback control buttons on the lower part of the screen. You can select multiple tracks by holding down the Control key as you select each one.

7 Add Tracks to Music Disc Creator
When you have selected the tracks you would like to convert, click the Add button at the bottom of your window. This does not automatically close Media Manager; you can continue to add files until you are finished. When you are finished, select Close.

8 Select Tracks Inside Music Disc Creator
When you have imported the tracks you are going to convert into Music Disc Creator, select them by clicking on each one while you hold the Control key down (or the Shift key if they are shown contiguously in Media Manager) or drag the mouse over them.
Right-click on Selected Tracks and Choose Export

With your mouse positioned over any part of the selected track, right-click to bring up the **Edit** menu. Choose **Export** to bring up the **Export Tracks** window.

Set Output Settings

After you have brought up the **Export Tracks** window, you need to choose the type of file to which you would like to convert your tracks. A WAV file is the highest quality file available. It is also the best option if you are planning to edit the audio file in any way. An MP3 or WMA file is the popular choice for use with your computer or digital media player. They take up a significantly smaller amount of space but can still be very good quality. Either one is a good choice; it just depends on your preference. If you are limited on space and don’t mind giving up quality, choose the lower-quality settings for the MP3 or WMA formats.

For the advanced user, you can also customize your audio. This option enables you to apply your own combination of settings, including an alternate file format, encoder type, bit rate, and file location. To define custom settings, click the **Edit** button to the right of the **Output settings** menu.

Choose Destination

When you have decided on your export settings, choose the location to which you would like the file saved. Make this a folder that is conveniently accessible and easy to remember. When it comes time to add these tracks to a project, you’ll want to be able to find them again.

**NOTE**

You can change the tags of your audio files in either **Music Disc Creator** or in the **Export** window by choosing the **Edit Audio Tags** button. If you would like help with this process, see **Add Tags to Audio Tracks**.

Click Export

When you are sure your settings are correct, click **Export** to save your files. You have successfully converted your files to a new format.
Add Tags to Audio Tracks

Editing your audio tags can be done in almost any interface involving individual audio tracks, not only in Easy Media Creator, but also in Windows. All you need to do is select the tracks you would like to add tags to and select the Edit Audio Tags option. This brings up the Edit Audio Tags window where you have quite a few options to make changing the tag on your tracks as easy as possible.

**KEY TERM**

Tags—Embedded data for a particular file. A tag can be added to an audio file, a data file, a photo file, or a video file. A tag can also have several components, such as a date, title, and so forth.

**NOTE**

Changing the audio tags does not change the name of your audio file. The tags are embedded inside your audio track and are recognized by Easy Media Creator as well as other playback software and devices. Windows Media Player displays audio tags, as will most digital audio players and newer CD players.

1. **Select Audio Track**
   Select your audio track from anywhere in Easy Media Creator or even anywhere on your computer.

2. **Select Edit Audio Tags**
   If you are in Easy Media Creator, chances are you have an Edit Audio Tags icon in your taskbar; simply click on it. If you don’t see the Edit Audio Tags option or you are browsing through Windows, right-click on your selected tracks and select Edit Audio Tags from the menu. This brings up the Edit Audio Tags window.

3. **Add Tags Or...**
   After you have launched the Edit Audio Tags window, you see a list of your selected tracks in the left side of the window. You can select any or all of these tracks and change their name, artist, album, genre, track number, and year by filling in the appropriate field. Preview your tracks by using the playback buttons on the bottom of the window.
Add Tags to Audio Tracks

You can also assign tags to your tracks by using MusicID. The MusicID button allows you to search the Gracenote online database for your track information. This works if your tracks have been recorded in their entirety and you haven’t made any major changes to them.

The MusicID status of each track is listed in the window along with the track name. You will find one of the following status indicators:

- **To be done**—MusicID has not been used to identify the track.
- **Identified**—One matching music database entry has been found by MusicID.
Add Tracks to Sound Editor

• **Multiple matches**—More than one music database entry matches your audio track. If this is the case, the status listing **Multiple matches** is a highlighted link. Click on this link to open up a window listing the matches found. If the correct name of your track is there, select it and click **OK**.

• **Could not identify**—Your audio track did not match any of the database entries. In this instance, you have to enter your tag manually.

5 Add Track Art

You can also add track art to your audio tag. Browse for the picture that you would like to associate with the track and click **OK**.

6 Embed Tags

Put a check mark next to the **Embed or replace tags inside the audio file** option if you would like your audio tags to be permanently embedded into your audio file. This enables other applications and software to recognize your audio tag.

**Add Tracks to Sound Editor**

<table>
<thead>
<tr>
<th>SEE ALSO</th>
</tr>
</thead>
</table>
| 1. Capture Music Tracks from a CD
| 2. Extract Audio Tracks from a DVD
| 4. Capture Audio Using Easy Audio Capture
| 5. Capture Audio Using the LP and Tape Assistant
| 6. Use the LP and Tape Assistant to Edit Newly Captured Audio |

**Sound Editor** is the full-fledged audio-editing application within Easy Media Creator. You can edit, mix, and add fun effects to your audio files using this application.

**Sound Editor** has all the capabilities of **LP and Tape Assistant** and **Quick Sound Editor**, plus a whole lot more. In **LP and Tape Assistant** you capture your audio file and then edit it. **Quick Sound Editor** is launched after the tracks you would like to edit are in place in a project, but **Sound Editor** is launched separately and requires you to import your audio files.
CHAPTER 3: Editing Audio

1. Launch Sound Editor
2. Select Add Audio File Or...
3. ...Select Import from CD/DVD
4. Browse to Find Audio Files
5. Select Tracks to Be Edited
6. Click OK or...
7. ...Select Record Audio
8. Click Done
9. Add Tracks to Sound Editor
Launch Sound Editor
The easiest way to launch Sound Editor is in the Easy Media Creator Home page. Choose the Home menu in the project pane, select Applications, and then select Sound Editor in the Applications window.

Select Add Audio File Or...
After you have launched Sound Editor, select the Add Audio File option to open the Media Selector window. This allows you to browse for audio files already saved on your computer (or network drives).

...Select Import from CD/DVD
After you have launched Sound Editor, select the Import from CD/DVD option to open Media Manager. This allows you to import tracks from an audio CD or to take the audio from a DVD track. This is an alternative method of extracting audio from a DVD. The other method is described in Extract Audio Tracks from a DVD.

Browse to Find Audio Files
After you have opened Media Manager, you need to browse through your drives and files to find the audio you would like to import. If you are searching for a file, it is found on your hard discs. If you are importing from a CD or DVD, you need to select your CD/DVD drive.

Select Tracks to Be Edited
After you have browsed to the location of the tracks that you would like to edit, you can select one or more tracks to be imported into Sound Editor. Preview your tracks using the playback control buttons on the lower part of the screen. You can select multiple tracks by holding down the Control key as you select each one.

Click OK Or...
When you have selected the tracks you would like to edit, click OK.

...Select Record Audio
After you have launched Sound Editor, select the Record Audio option to open the Record Audio window. The Record Audio interface is almost exactly the same as the Easy Audio Capture interface described in Capture Audio Using Easy Audio Capture. The only additional feature of the Record Audio interface is the Add Track Separator button. This allows you to split your audio into two or more tracks as it is being recorded.
CHAPTER 3: Editing Audio

▶ TIP
If you are planning to record several tracks, it is much more convenient to use LP and Tape Assistant. You can set options within LP and Tape Assistant that automatically detect and separate your tracks. By doing this, you won't be required to closely monitor your recording.

8 Click Done
When you are finished recording the audio you would like to edit, click Done.

10 Split, Crop, and Join Tracks

✔ BEFORE YOU BEGIN
9 Add Tracks to Sound Editor

→ SEE ALSO
11 Fade Volume of an Audio Track
12 Mix Multiple Audio Tracks

There are two windows to view your tracks, the Clip Editor and the Mix Editor. Use the Clip Editor to edit the track and the Mix Editor to position your clips.

1 Add Markers
Launch Sound Editor and add the audio tracks you would like to edit. Click anywhere inside the clips shown in the Clip Editor to place a selection line. Right-click on the selection line and select Add/Remove Marker. This adds a marker to your audio track. Of course, you can remove a marker in the same way.

▶ TIPS
A faster way to add markers to your clip is to place the selection line and then use the M key to add each marker.

You can also automatically detect tracks within your audio file to add markers to it. This is helpful if you have recorded audio that contains more than one music track. Select Track Detection from the Tools drop-down menu.

2 Click on Split Clip
After you have set markers in place, click on Split Clip. This opens the Split Clip window.
Split, Crop, and Join Tracks

1. Add Markers
2. Click on Split Clip
3. Select Current Position or Markers
4. Crop to Selection
5. Cut Unwanted Clips
6. Position Clips for Joining
7. Select Multiple Tracks
8. Click Join Clips
3 Select Current Position or Markers

The Split Clip window gives you the option to split the clip at your current position or at all markers. Choose which option you would like and the operation is completed.

4 Crop to Selection

If you are only interested in editing a small portion of the track, select that portion and choose Crop to Selection in the Edit menu. This crops the picture and deletes anything that is not selected.

► KEY TERM

Crop—to delete the unselected portion of a file.

► TIP

Any time you have something selected, you can zoom to that selection by using the zoom tools in the upper right of your view or by right-clicking on the selection and choosing Zoom to selection. When you are done editing your particular selection, you can zoom back to your full view the same way.

5 Cut Unwanted Clips

Select the portion of track you would like to crop in the Clip Editor and click the Cut option in the taskbar.

6 Position Clips for Joining

Using the Mix Editor, position your clips in the order you would like them joined. They don’t need to be right next to each other for the joining to work.

7 Select Multiple Tracks

After you have positioned your clips, select the tracks you would like to join by holding down the Control key and clicking on each one.

8 Click Join Clips

After you have selected the clips you would like to join, click Join Clips. This pulls the clips together and seams them as if there had never been a split.
Setting the volume and fading your audio tracks are two of the most obvious changes you can make. Fading a clip into the next one creates a very nice transition between the two. Of course, that is an obvious use of volume control. You can change the volume—or the balance—of any portion of your track for any number of reasons. You might want to adjust the volume in order to add a sound effect or change the balance to create a sound effect.

**NOTE**

These steps offer a more precise way to adjust the volume of your track. You can also adjust the volume manually by right-clicking on the Volume or Balance windows and placing one or more nodes on the line. You can move these nodes at will to adjust the volume or balance settings.

1. **Select the Track to Fade**
   
   Select the track you would like to fade by clicking on it in the Mix Editor; this places it in the Clip Editor.

2. **Select Area of Track to Fade**
   
   Choose a portion of the track to fade by either placing a selector line in the place that you would like to fade or by selecting a portion of the track.

3. **Click the Fading & Volume Button**
   
   After you have selected the portion of the track you would like to fade, click the Fading & Volume button. The Fading & Volume menu is displayed.

4. **Choose Your Fading Option**
   
   The Fading & Volume menu has the following options:
   - **Fade In**—Used primarily at the beginning of a track (although it can be used anywhere), this option brings the track from silence up to its set volume level. If you have placed a selector line without highlighting a portion of the track, the fade in carries through the rest of the track, coming up to its set volume in the end.
CHAPTER 3: Editing Audio

- Select Area of Track to Fade
- Click the Fading & Volume Button
- Select the Track to Fade
- Choose Your Fading Option
- Set the Duration of the Fade

Fade Volume of an Audio Track
• **Fade Out**—Used primarily at the end of a track (although it can be used anywhere), this option brings the track from its set volume level down to silence. If you have placed a selector line without highlighting a portion of the track, the fade out carries through the rest of the track, finally fading to silence in the end.

• **Fade In and Out**—This option can be used for a variety of reasons. For example, you can soften the transition between merged tracks, or soften a section of music to allow for a voice-over. If you have placed a selector line without highlighting a portion of the track, you are prompted to enter the duration of the fade effect in seconds.

• **Adjust Volume**—This option allows you to adjust the volume of your selected track.

• **Adjust Balance**—This option allows you to adjust the volume balance of the right and left channels at different volume settings.

> **KEY TERM**

*Balance*—The volume of the right channel relative to the volume of the left channel of audio.

After you have selected your option, the fade takes effect.

5 **Set the Duration of the Fade**

If you selected **Fade In and Out**, you are prompted to set the duration of the fade in seconds. Set the duration and click **OK**.

> **TIP**

If you are dissatisfied with your volume or balance settings, you can quickly reset these values by choosing **Reset Volume Envelope** or **Reset Balance Envelope** in the **Fading & Volume** menu.

---

**BEFORE YOU BEGIN**

1. Add Tracks to Sound Editor

**SEE ALSO**

11 Fade Volume of an Audio Track
12 Mix Multiple Audio Tracks
CHAPTER 3: Editing Audio

1. Add Right Audio Track
2. Add Second Layer
3. Add Left Audio Track
4. Position Tracks
5. Adjust Balance on Right
6. Adjust Balance on Left

Set the Right and Left Audio Track
Clean, Enhance, and Equalize an Audio Track

In order to set a right and left audio track, you need two tracks that coincide with each other. You can do this by adding layers to your project. This is really a very simple task that gives you the capability to add fun effects to your audio.

1. **Add Right Audio Track**
   Add the audio track you would like to play in the right channel to Sound Editor.

2. **Add Second Layer**
   Add layers to your Sound Editor project by clicking on the Add Layer button (the plus sign) in the left of the Mix Editor under the layer name.

### KEY TERM

**Layer**—A separate component within a larger project that can be manipulated independently of the other components of the project.

3. **Add Left Audio Track**
   After you add a second layer, select it. Add the audio track for the left channel.

4. **Position Tracks**
   Position your tracks in the desired location. You can do this simply by dragging them into place inside the Mix Editor.

5. **Adjust Balance on Right**
   Select the top track, displaying it in the Clip Editor. Set the balance to the right channel by dragging the line in the balance area all the way down.

6. **Adjust Balance on Left**
   Select the bottom track, displaying it in the Clip Editor. Set the balance to the left channel by dragging the line in the balance area all the way up.

---

**BEFORE YOU BEGIN**

1. Add Tracks to Sound Editor

**SEE ALSO**

4. Use LP and Tape Assistant to Edit Newly Captured Audio
CHAPTER 3: Editing Audio

1. Select Track
2. Select Clean up Audio
3. Clean Audio
4. Enhance Audio
5. Adjust Audio Equalization
6. Click OK

13. Clean, Enhance, and Equalize an Audio Track
Clean, Enhance, and Equalize an Audio Track

1 Select Track
Select the track (or portion of track) you would like to clean, enhance, or equalize by clicking on it in the Mix Editor.

2 Select Clean up Audio
After the track is selected, click on the Clean up Audio button in the Clip Editor taskbar to bring up the menu. From this menu you can choose Clean, Enhancer, or Equalizer.

3 Clean Audio
After you have opened the Clean up Audio menu, click the Clean button. In the Clean dialog that opens, you can declick, decrackle, denoise, or add noise manually by selecting Custom (the default) at the bottom right of the pane and adjusting the sliders for each function until the cleaning effect is properly applied. You can also have the effect applied via Sound Editor presets by choosing a low, medium, or high setting from the bottom-right drop-down menu. Play the track that you are cleaning to hear the effect as you adjust it.

TIP
Because the cleaning effects are layered on top of each other as you apply them, you should add the effects one at a time, adjusting each as necessary.

4 Enhance Audio
After you have cleaned your audio, you can enhance it by selecting the Enhancer option. You can choose to enhance the Bass, or make your audio brighter by enhancing the Excite. There are no presets for either enhance function, so you need to adjust the effects manually with the slider provided.

5 Adjust Audio Equalization
When you are satisfied with the enhancement settings of your audio, choose the Equalizer option to use Easy Media Creator’s 10-band equalizer to change the levels of your audio track. You can use the presets, or customize your settings by adjusting the levels manually. Customizing your settings is mostly a trial-and-error process, so change one setting at a time and listen to your track to monitor the differences. There is a left and right channel indicator for each band. You can adjust these separately by deselecting the Link channels option.


**NOTE**
As you add effects to your audio, you will notice a **Bypass** and (sometimes) a **Difference** selection in the effect adjustment windows. As you preview your audio, you can select **Bypass** to listen to your audio without the effect, or **Difference** to hear the difference the effect is having on the audio without the rest of the audio. Where **Difference** isn’t available, simply deselect **Bypass** to preview the audio with the effect applied.

---

**Add Effects to an Audio Track**

**BEFORE YOU BEGIN**
- Add Tracks to Sound Editor

**SEE ALSO**
- Split, Crop, and Join Tracks
- Fade Volume of an Audio Track
- Set the Right and Left Audio Track
- Clean, Enhance, and Equalize an Audio Track
- Mix Multiple Audio Tracks

---

After you have cleaned up your audio, you might want to add effects. Effects allow you to apply a filter to the audio that adjusts the sound of the track. You can apply effects to set a uniform volume level for tracks, improve the quality of the track, convert a track from mono to stereo, or just add a fun element to the sound of the audio.

**Sound Editor** allows you to add multiple effects to the same track, a portion of the track, or multiple portions of tracks. This feature allows you to be very creative in making the most of the effects available for audio tracks.

**Normalize Track**

The one effect that you will want to use on virtually every audio track is **Normalize**. The **Normalize** effect enables you to give audio tracks a uniform level of volume by increasing the loudest level in the track to match a specific range in the sound editor. The entire volume level of the track is either increased or decreased to make the loudest part match the maximum level you specify. You can normalize your track by following these steps:

1. **Select the Track**
   
   If you have multiple tracks loaded in the project, make sure you select the one you want to normalize or apply audio effects to.
2. Select Normalize

Select the Fading & Volume button and choose Normalize. This brings up the Normalize effect window.

3. Set Volume Level

Use the slider to adjust the volume to the level desired for audio in this project.

4. Preview the Audio

You can preview the loudness by pressing the Play/Stop button. While listening to the audio, you can select the Bypass check box to quickly bypass the normalization effect to hear the original audio.

5. Click OK

After you have the normalize level set to the appropriate value, click OK.

**NOTE**

You can also maximize the volume of a clip. Maximizing the clip renders each layer to play at the same volume, and can be a critical function if the volume variance is easily distinguishable. This is not always recommended, however. If the volume of a clip is very low, you might cause the audio to become distorted or clipped if you maximize it. Maximized clips also tend to be a little bit louder than normal audio CDs, forcing you to adjust the volume of the playback device.

2 Add Effects

With the track selected, select Sound Effects and choose one of the following effects to apply to the audio track. You can also apply effects to a specific portion of the track by highlighting only that portion of the track:

- **Alienizer**—Adds a metallic timbre to the sound.
- **DeVoicer**—Attempts to remove voices from the audio.
- **Digital Hall**—Adds the echo effect that you might get in a large building.
- **Maturizer**—Adds static and other effects to make audio sound like an old LP or radio signal.
- **Mono to Stereo**—Changes mono audio to sound like stereo with different tracks in each speaker.
- **Parametric Equalizer**—Allows you to equalize the audio with an easy-to-use interface.
CHAPTER 3: Editing Audio

1 Normalize Track

2 Add Effects

3 Preview the Effect

4 Adjust the Effect Settings

5 Click OK

14 Add Effects to an Audio Track
Mix Multiple Audio Tracks

- **Pitch**—Adjusts the pitch of the audio.
- **RoboVoice**—Adds an electronic timbre to the sound.
- **Stereo Enhancer**—Amplifies the stereo effect of the audio to make it more apparent.

3 **Preview the Effect**

You can preview the loudness by pressing the Play/Stop button. While listening to the audio, you can select the Bypass check box to quickly bypass the normalization effect to hear the original audio.

4 **Adjust the Effect Settings**

Each effect has its own controls, allowing you to adjust what the effect does to the audio. Adjust the effects while the audio is playing and tweak the effect until you get the best result.

5 **Click OK**

After you have the desired effect, click OK. You can add additional effects to the track by repeating steps 2 through 5.

**NOTE**

As you add effects to your tracks, you can undo them at any time by selecting Edit, Undo in the File menu. Keep in mind that although you can continue to undo several actions, your effects are undone in the reverse order that you applied them.

**TIP**

You should always normalize all audio tracks for a project to the same level. This makes the volume of each track match and removes the risk of having one track sound much softer than the other tracks.

**BEFORE YOU BEGIN**

- Add Tracks to Sound Editor
- Split, Crop, and Join Tracks

**SEE ALSO**

- Fade Volume of an Audio Track
- Set the Right and Left Audio Track
- Clean, Enhance, and Equalize an Audio Track
- Add Effects to an Audio Track
CHAPTER 3: Editing Audio

1. Add Layers
2. Add Audio Tracks
3. Edit Individual Clips
4. Position Clips
5. Adjust Layer Weight
6. Add Track Separators

Mix Multiple Audio Tracks
Mix Multiple Audio Tracks

1 Add Layers
Add Layers to your Sound Editor project by clicking on the Add Layer button (the plus sign) in the left of the Mix Editor under the layer name.

2 Add Audio Tracks
After you have added an appropriate number of layers, add the audio tracks you would like to mix. Select the layer you would like the track dropped into before you import it.

3 Edit Individual Clips
After you have imported your clips, edit your clips individually to suit your needs. For example, you probably want to crop or join some of your clips or set the channels on each clip.

4 Position Clips
Position your tracks in the desired location. You can do this simply by dragging them in place inside the Mix Editor.

5 Adjust Layer Weight
After you have edited each clip, adjust the weight of each layer by moving the slider in the layer window back and forth. The heavier the layer weight, the louder that layer sounds in comparison to the other layers.

6 Add Track Separators
After you are done mixing your clips, you can add track separators to create new tracks within your mix. Position the selection line in the location that you would like to divide the tracks. You can do this in the Clip Editor or the Mix Editor. Right-click on the selection line and choose Add New Track. The clip is split and identified as two separate tracks.

NOTE
After you have edited and mixed your audio to your satisfaction, you want to save your new tracks. Use the Export options on the right of the Sound Editor window to export your tracks to a file, to a Music Disc Creator project, or to burn it onto a CD.
After you are done editing your audio in Sound Editor, there are many options for exporting it. You can export just an edited clip or track, export the whole mix, burn the mix to CD, or add it to Music Disc Creator. You can also save an unfinished project so you can open and finish it later.

It is important to review the information on file formats in Chapter 1, “Start Here,” so you know what your best option is for saving your mix.

Also, be sure to choose a destination for your files that is organized and easy to find so you can find the files when it comes time to add them to a project.

1. **Save Sound Editor Project**

   If you would like to save an unfinished project, choose Save Project from the File menu. This brings up the standard Save As window where you are able to choose a file name and destination. The file will have a .dmse extension that enables Sound Editor to locate it when you ask the program to open an existing project.

2. **Export Current Clip**

   If you would like to save a single edited clip, select the clip you would like to export and click Export Current Clip in the Export menu to open the Export Current Clip window. You can choose the file format you would like to save your clip to, the destination, and the name. After you are finished selecting these options, click Export.

3. **Export Mix**

   If you would like to save the mix you have created, click Export Mix in the Export menu to open the Export Mix window. You can choose the file format you would like to save your clip to, the destination, and the name. After you are finished selecting these options, click Export.
CHAPTER 3: Editing Audio

4 Export Tracks/Clips

5 Burn Audio CD

4 Add to Music Disc Creator

16 Export Audio (continued)
4 Export Tracks/Clips
To save one or more tracks or clips from your project, click Export Tracks/Clips in the Export menu to open the Export Tracks/Clips window. In this window you can choose whether to export the tracks or the clips and you can deselect any that you do not want to export. Choose the file format you would like to save your clip to, the destination, and the name. After you are finished selecting these options, click Export.

5 Burn Audio CD
To burn your mix to a CD, click Burn Audio CD in the Export menu to open the Burn Audio CD Wizard. You can use the tracks or the clips from the project and deselect any tracks that you do not want burned. By clicking the Audio CD Settings button, you can name the disc and the artist and choose to maximize the volume as the CD is being burned to ensure that the audio is burned at the same level. In this settings window you can also choose to have CD-text information stored on the disc. Make sure that you will have enough room on your CD to hold the tracks, and place an empty CD in your burner. When you are finished with the settings, click OK to exit the settings window, and then click Burn.

6 Add to Music Disc Creator
To add your mix to an advanced audio project as a track, click Add to Music Disc Creator in the Export menu to open Music Disc Creator. The mix is automatically added to Music Disc Creator as it is opened, and you can continue to add tracks from Sound Editor projects or other sources to your advanced project so you can save it or burn it to CD.